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INTRODUCTION

Using a GlobalSign PersonalSign Digital ID you can add digital signatures to Microsoft® Office documents (i.e.,
Word, Excel, PowerPoint, and Outlook emails) to provide authenticity, integrity, and origin of the document.

e Authenticity — the digital signature helps to assure that the signer (such as the document author or the
email sender) is who he or she claims to be.

e Integrity — the digital signature helps to assure that the content of the document or email has not been
changed or tampered with since it was digitally signed.

¢ Non-repudiation — the digital signature helps to prove to all parties the origin of the signed content.
“Repudiation” refers to the act of a signer’s denying any association with the signed content.

Please note: If you want to sign a VBA macro, you will need to obtain a Microsoft® Authenticode Code Signing
Certificate. This is true regardless of the program in which the macro was created. For more information on Code
Signing Certificates, please visit http://www.globalsign.com/code-signing/ .

TYPES OF SIGNATURES

There are two types of signatures you can add to Microsoft® Documents: a non-visible signature and a
visible signature. The type of signature that can be added is dependent upon the type of document you

want to sign.
Microsoft Office Product Visible Signature Non-visible Signature
Word v v
Excel v v
PowerPoint N/A 4
Outlook N/A 4

NON-VISIBLE SIGNATURE

A non-visible signature cannot be seen within the contents of the document itself; however, recipients
of the document can determine that the document has been digitally signed by looking for the red
ribbon in the document status bar at the bottom of the screen or viewing the signature pane. This
method is commonly used when you need to provide authenticity, integrity, and origin assurances, but
do not necessarily need a visible signature line.

Non-visible signatures can be added to Microsoft® Word, Excel, and PowerPoint documents, as well as
Microsoft® Outlook emails.


http://www.globalsign.com/code-signing/

ADDING A NON-VISIBLE SIGNATURE TO A WORD, EXCEL, OR POWERPOINT DOCUMENT

1. Once you have a document open you wish to digitally sign, click the File tab and select Info from

.i' Home
H Save

Save As
[ﬁ Open
[ Close

2. Inthe Permissions section click Protect Document/Workbook/Presentation and select Add a
Digital Signature.

the left menu.

ﬂ Close L.
; Permissions
E%B_\j Anyone can open, copy, and change any part of this document,
Protect
Recent Document ~
Mark as Final
e Let readers know the document is final
and make it read-anly.
Print f=] Encrypt with Password that it contains:
gﬁ Require a password to open this uthor's name
Save & Send document.
Restrict Editing sabilities are unable to read
Help Control what types of changes people
can make to this document.
7 Add-Ins - Add a Digital Signature
Ensure the integrity of the document [} )

,ﬁ Options by adding an invisible digital signature,

3. A Microsoft Office dialog box will appear with information on digital signatures. Click OK.

Microsoft Office Word |5

Microsoft Office digital signatures combine the familiarity of a paper signing experience with the convenience of a digital format. While this feature provides users with the ability to
verify a document’s integrity, evidentiary laws may vary by jurisdiction. Microsoft thus cannot warrant a digital signature’s legal enforceability. The third-party digital signature
service providers available from the Office marketplace may offer other levels of digital signature assurance.

|| Don't show this message again

[ signature Services from the Office Marketplace... | | oK

4. If you haven’t already saved your document, another Microsoft Office dialog box will appear
stating you must first save the doucment before you can add the digital signature. Acceptable
formats include, .docx, .xlsx, .pptx, .doc, .xls, and .ppt.
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: Before you can add signatures, you must save the documentin a format that supports digital signatures.
__I_l Do you want to save the document as a Word Document?

[ Yesbr] [ Mo ] ’ Help ]

Microsoft Word

5. Next, the Sign dialog box will appear. You have the option of adding a reason for signing the
document or leaving this field blank. You also have the option to choose a digital signature if

you have multiple digital IDs.

A=)

Sign

o See additional information about what you are signing...

19 | You are about to add a digital signature to this document. This signature will not be
visible within the content of this document.

Purpose for signing this document:

|
Signing as:  Julie Olenski

H Issued by: GlobalSign PersonalSign Class 2 CA
[ Sign [}] [ Cancel ]

6. The Signature Confirmation dialog box will appear next informing you that the signature was
saved within the document and if the document should change, the signature will become

invalid.

N
Signature Confirmation
s

Your signature has been successfully saved with this document.
If the document is changed, your signature will become invalid.

on't show this message again
Don't show thi ge agai
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!
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7. A notification will appear at the top of the document stating that the document has been
marked as final and should not be edited and a red certificate icon will appear in the bottom

pane of the document.

o Marked as Final An author has marked this document as final to discourage editing. Edit Anyway

Page:1of1 | Words:0 | B k‘

- it B A
f " This document contains signatures.
] — ||

Clicking the red ribbon opens the Signatures pane. You can click the dropdown arrow next to a
signature to view Signature options, such as Signature Details and Remove Signature.



Signatures v X

z"j Valid signatures:
Julie Olenski 12/19/20 =]
A Sign Again..,
Signature Details..

Signature Setup...

Remove Signature

Clicking Signature Details will bring up the Signature Details dialog box, which verifies that the
signature is valid and provides the Certificate Issuer. You can find further details about the
Certificate by clicking View.

-
Certificate g

General | Details | Certfication Path

Signature Details PR § Certificate Information
I
1253 _ » o _
Valid signature - This signature and the signed content have not been This certificate is intended for the following purpose(s):
E;j modified since the signature was applied.  Proves your identity to a remate computer

» Protects e-mail messages
Signature type: XAdES-EPES

Purpose for signing this document:

*Refer to the certification authority's statement for details.

Signing as:  Julie Olenski
Issued by:  GlobalSign PersonalSign Class 2 CA

See the additional signing information Issued by: GlobalSign PersonalSign Class 2 CA
that was collected...

valid from 1/ 20/ 2011 to 3/ 21/ 2012

Miew.... Issued to: Julie Olenski

T) ‘You have & private key that corresponds to this certificate.

Issuer Statement

Learn more about £

8. Any changes to the document after the digital signature is in place will invalidate and remove
the signature.

ADDING A SIGNATURE TO A MICROSOFT OUTLOOK EMAIL

1. Once you have an email drafted that you wish to digitally sign, click the Options tab at the top of
the window and select Sign in the Permission section.

Insert Options Format Text

R = =
J I=d i = Encyp

Bcc  From %1 Sign

Fonts =
Themes P
- [O]effects ~

Themes Show Fields Permission




2. If the email recipeint uses S/MIME security, the email will appear with a red ribbon icon in the
recipient’s inbox. An attachment icon will also appear. The digital signer’s name will also
appear under the subject line at the top of the email when the email is open.

V2| D) @ From Subject

4 Date: Today
43  © John Smith Example Signed Email

MICROSOFT OUTLOOK DIGITAL SIGNATURE SETTINGS
You can change your Outlook settings so all outgoing messages are automatically digitally signed.

1. With Outlook open, click the File tab in the upper left corner and select Options.

‘ File | Home Send
[ﬂSa\reAs

Info

Open
Print
Help

2] Options
N

2. When the Outlook Options dialog box appears, select Trust Center from the left menu and then
select Trust Center Settings.

Outlook Options — 2. o]
e L . - L Y
General
Help keep your documents safe and your computer secure and healthy.
Mail
Calendar Protecting your privacy
Contacts Microsoft cares about your privacy. For more information about how Microsoft Outlook helps to protect your privacy,
please see the privacy statements.
Tasks

Show the Microsoft Outiook privacy statement
Motes and Journal Office.com privacy statement
Customer Experience Improvement Program

Search

Mobile Security & more

Language Learn more about protecting your privacy and security fram Office.com.

Advanced Microsoft Trustworthy Computing

|| customize Ribbon Microsoft Outlook Trust Center

Quick Access Toolbar The Trust Center contains security and privacy settings, These settings help keep your e e
computer secure. We recommend that you do not change these settings. Trust Center Settings... E

Add-Ins

| Trust Center |
[

3. After the Trust Center dialog box appears, select E-mail Security from the left menu and check
the box next to Add digital signature to outgoing messages.



Encrypted e-mail

9 |:| Encrypt contents and attachments for outgoing messages
. @ Add digital signature to outgoing messages
end clear text signed message when sending signed messages
[7] Request S/MIME receipt for all S/MIME signed messages

Default Setting: | My S/MIME Settings (julie.olenski@globalsign.com) El Settings...

4. This screen provides other options for configuring your Outlook e-mail security settings.

a. Encrypt contents and attachments for outgoing messages — checking this box will
automatically encrypt all outgoing messages sent from your account. Please note,
recipients will only be able to decrypt the message if they also use S/MIME security and
you have exchanged keys with them.

b. Send clear text signed message when sending signed messages — checking this box will
allow recipients who don’t use S/MIME security to be able to read the message. This
box is checked by default.

c. Request S/MIME receipt for all S/MIME signed messages — checking this box will
prompt notifications, sent to your inbox, detailing who opened your message and when.
This option verifies that your digitally signed message was received by the intended
recipient.

d. If you have multiple digital certificates, you can choose which one to use by clicking the
Settings button next to the Default Setting box.

VISIBLE SIGNATURE

Another way to add a digital signature to a document is to add one or more digital signature lines.
Adding one or more digital signature lines to a document allows you to specify the individuals who must
sign the document. The signer applies his or her own digital signature on the signature line created.

Visible signatures can be added to Microsoft® Word and Excel documents.

12/19/2011

X John Smith
Jebn Smigh

Director of Sales
Signed by: John Smith

Visible Signature

ADDING A VISIBLE DIGITAL SIGNATURE TO A MICROSOFT WORD OR EXCEL DOCUMENT
1. Once you have a document you would like to add a signature line to, select the Insert tab at the
top of the screen and then click Signature Line.

a. Microsoft® Word
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53, Date & Time
Text Quick WordArt - .
Box~ Partsw - '§d Object ~

Text

b. Microsoft® Excel

A — [
Af B J &
Text Header WardArt Signature| Object

Box & Footer ~ Line =
Text

2. When the Signature Setup box appears, enter information about the suggested signer, such as
the name, title, and email address. You can check the “Allow the signer to add comments in the

Sign dialog” if you want the signer to be able to add additional information into the signature
line.

-

Signature Setup I. & ﬁ]

Suggested signer (for example, John Doe):
John Smith

Suggested signer's title (for example, Manager):
Director of Sales

Suggested signer's e-mail address:

Instructions to the signer:

Before signing this document, verify that the content you
are signing is correct,

[ Allow the signer to add comments in the Sign dislog
Show sign date in signature line

[ Ok ] [ Cancel

3. Adigital signature line will now appear in the document.

X

John Smith
Director of Sales

4. Repeat steps 1 — 3 until you have the desired number of digital signature lines.

X X

John Smith Jane Johnson
Director of Sales Direct of Operations




7.

8.

You can now distribute the document to the necessary recipient(s). Upon receiving and opening
the document, recipients will be met with a notification that the document needs to be signed.

0 Signatures  This document needs to be signed. View Signatures... I:}

Clicking View Signatures opens the Signatures panel, which lists all Requested Signatures
included in the document.

Signatures * X

&% Reguested signatures:
John Smith

Jane Johnson

To digitally sign the document, users can either right click the signature line or right click their
names in the Signatures panel.

Signatures v X
" - ' &% Reguested signatures:
Cut
& = John Smith =
= | C .
=3 Copy Jam a §|gn...
.x [, Paste Options: .
J?hn Smith = Signature Setup...
Director of Sales ':n
sign... Femowve Signature
: % = e Signature

In the Sign dialog box, the signer can type his or her name or can click Select Image and insert
an image file containing a handwritten signature or other image of choice. If the signer has
multiple digital certificates, he or she can designate the correct certificate by clicking Change.

Sign D | |

o See additional information about what you are signing...

Before signing this document, verify that the content you are signing is correct.

Type your name below, or dick Select Image to select a picture to use as your
signature:

X John Smith|

John Smith
Director of Sales

Select Image...

Signing as:  Julie Clenski
Issued by:  GlobalSign PersonalSign Class 2 CA =

10



9. Once digitally signed, the signer’s name, or the chosen image, will appear next to the ‘x’ on the

signature line and a notification will appear at the top of the document stating that the

document has been marked as final and should not be edited. A red ribbon will also appear at

the bottom of the document.

ﬂ Marked a5 Final | An author has marked this document a5 final i discourage editing.

Edit Armpway
12/19/2011 12/19/m11
x John Smith x Jane Johnson
Joihn Smith June Jofveon
Derecter of Sales Derect of Operatons

Signed by John Smith

Signied by: Jene Johnsen

9. To view Certificate details, you can double- or right-click the signature line, or click the red

ribbon and right click a given signature in the Signatures Pane and select Signature Details.

10. This will open the Signature Details dialog box, which verifies that the signature is valid and

provides the Certificate Issuer. You can find further details about the Certificate by clicking

View.

Certificate [

General | Details | Certification Path

g Certificate Information

This certificate is intended for the following purpose(s):

« Proves your identity to a remote computer
* Protects e-mail messages

*Refer to the certification authority's statement for details.

Signature Details P 0=
valid signature - This signature and the signed cantent have not been
£} medified since the signature was applied.
Signature type: XAJESEPES
Purpose for signing this document:
Signing as:  Julie Olenski =
Issued by:  GlobalSign PersonalSin Class 2 CA -
See the additional siqning information
that was collected...

Issued to: Julie Olenski
Issued by: GlobalSign PersonalSign Class 2 CA

valid from 1/ 20/ 2011 to 1/ 21/ 2012

‘7 You have a private key that corresponds to this certificate.

Issuer Statement

11. Any changes to the document after the digital signatures are in place will invalidate and remove

the signatures.

11



GETTING HELP

GlobalSign provides technical support through our Client Service departments around the world.
www.globalsign.com/support

GlobalSign US & Canada
Tel: 1-877-775-4562
www.globalsign.com
sales-us@globalsign.com

GlobalSign EU

Tel: +32 16 891900
www.globalsign.eu
sales@globalsign.com

GlobalSign UK

Tel: +44 1622 766766
www.globalsign.co.uk
sales@globalsign.com

GlobalSign FR
Tel: +33 182 8801 24
www.globalsign.fr

ventes@globalsign.com

GlobalSign DE
Tel: +49 30 8878 9310
www.globalsign.de

verkauf@globalsign.com

GlobalSign NL
Tel: +31 20 8908021
www.globalsign.nl

verkoop@globalsign.com

12



		2011-12-28T12:28:43-0500
	Marketing




